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DAY TWO

· Creating Forms

· Creating multi-table forms

· Customizing Forms using combo boxes and option group forms

· Adding date/time 

· Inserting page numbers

· Generating Reports using a single table and using multiple tables

· Customizing Reports

· Calculating group totals and overall totals

· Integrating Access with other programs

· Exporting an Access table as an Excel worksheet

· Automating tasks with macros

· Choosing actions for a macro

· Adding actions to a macro

· Single-stepping a macro

· Adding a MsgBox action

· Adding a list box to a form

· Testing and Debugging 

MODIFYING A FORM WIZARD FORM

Creating a Form Wizard Form

Creating a form using the Form Wizard is quick and easy, but may not always provide exactly the form you need.  Fortunately, making changes to a form’s design is simple.

To modify a form’s design, switch to design view.  If you are already viewing the form in Form view, click the design view button in the toolbar.

If the form is not yet open, follow these steps to open it in form design view:

1. Open the database that contains the form.

2. Click the Form button along the top of the Database window and

3. In the forms list box, highlight the form name and click Design.  Access opens the form window in Design view.

The Form window provides many ways for you to enhance your form design, as shown in the following figure.
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TO INSERT THE DATE

1 Click the unbound text box field to select it.  Click the right mouse button to drop down a menu.  

2 Select properties

3 In the Control Source field of the format window type =Now() (Now() is a built function the inserts the system time and date onto a form or report.  This is very useful if your reports are time and date sensitive.)

TO INSERT THE PAGE NUMBER

1 Choose the Insert Menu

2 Click Page Number

3 Set all of the criteria in the window that pops up

4 Click okay

CREATING MUTIPLE TABLE FORMS

Now that you are familiar with the fundamentals of working with multiple tables, you are ready to build multiple forms.

A multiple form is one or more subforms embedded in a main The main form is displayed in Form view.  Each subform is displayed in datasheet view.  Typically, the main form is based on the one-side table in a one-to-many relationship, with each subform on a many-side table.  You can create a multi-table form based on a many-to-one relationship; but it is preferable to base such a form on a query rather than the underlying tables.  You usually can scroll through the records much faster when a many-to-one multiple form is based on a query.

Subforms - What they are and how they work

A subform is a form within a form.  The primary form is called the main form and the form within the form is called the subform.  A form/subform combination is often referred to as a hierarchical form, a master/detail form, or a parent/child form. To create a multiple forms, tables relationships have to be one to many.

Subforms are especially effective when you want to show data from tables or queries with a one-to-many relationship. A good example of this can be found in the Northwinds Database.  If you open the Categories Form you will observe that it is a form with a subform.  The data in the Categories table is the "one" side of the relationship.  The data in the Products table is the "many" side of the relationship; each category can have more than one product.

The main form and subform in this type of form are linked so that the subform displays only records that are related to the current record in the main form.  For example, when the main form displays the Beverages category, the subform displays only the products in the Beverages category.

When you use a form with a subform to enter new records, Microsoft Access saves the current record in the main form when you enter the subform.  This ensures that the records in the "many" table will have a record in the "one" table to relate to.  It also automatically saves each record as you add it to the subform.

A subform can be displayed as a datasheet, as in the preceding illustration, or it can be displayed as a single or continuous form.  A main form can only be displayed as a single form. 

A main form can have any number of subforms if you place each subform on the main form.  You can also nest up to two levels of subforms.  This means you can have a subform within a main form, and you can have another subform within that subform.  For example, you could have a main form that displays customers, a subform that displays orders, and another subform that displays order details.

Drop-down list boxes and Combo boxes are powerful new controls you can add to your Visual Basic application.
When you use a wizard to create a list box or combo box, MS Access sets certain properties for the control.  You can work with these properties directly if you don't want to use a wizard to create the control, or you can use a wizard to create the control and then modify these properties to make the control work just the way you want.  To find out more about any of the following properties, click the property in the property sheet and press F 1.

Note: If you're creating or modifying a bound fist box or combo box, you can set most of these properties in table Design view instead of using the control's property sheet.  This way, you can specify the properties once.  When you add the field to a form, MS Access automatically creates the control based on the properties you specified.

The following page contains the items in a control’s property box and what the significance of each is.

PROPERTY
DESCRIPTION

RowSourceType
Works together with the RowSource property.  You specify the type of Row Source (table/query, value list, field list, or Visual Basic function) using this property and then specify actual RowSource in the RowSource property.

RowSource
 Specifies the name of the table, query, or SQL statement if RowSourceType is set to Table/Query; specifies the entries in the list, separated by semicolons, if RowSourceType is set to Value List; specifies the name of the table or query if RowSourceType is set to Field List; is blank if RowSourceType is set to a function name.

BoundColumn 
In a bound multiple-column List box or Combo box, specifies which column is bound to the underlying field specified in the ControlSource property.  Data in that column will be stored in the field when you select that item in the list.  This data may be different from the data displayed in the list if you hide the column.

ColumnCount 
Specifies the number of columns in a list box or combo box.  You can include a column but not display it in a list by setting the ColumnWidths property.  You might want to do this if you have a list that looks up values from a table or query.  You could include an ID field but hide it in the list.  In a combo box, the first visible column in the list is displayed in the text box portion of the combo box.

ColumnWidths
Specifies the width of each column, separated by semicolons.  Enter 0 to hide a column.  Enter a semicolon without a measurement to use the default (about I in. or 2.5 cm).  In a Combo box, the first visible column is displayed in the text box portion of the control.  The data type of any value you type in the combo box must be the same as or compatible with the data type of the first visible column.

ColumnHeads.
Determines whether the field names from the underlying row source for a combo box or list box are used as column headings in the Combo box or List box.  Headings appear in combo boxes only when the list is dropped down.

ListWidth      
Specifies the width of the list box portion of a combo box.

ListRows      
Specifies the maximum number of rows to display in the list box portion of a Combo Box.

LimitToList 
Determines whether a Combo box accepts any entered text or only text that matches  one of the values in the list.  If you want to allow a new value that a user enters to be added to the list, set the property to No and attach an event procedure to the OnNotInList property.

OnNotInList 
Runs the attached event procedure when the OnNotInList event occurs.  You can use this property to automatically add a new value to a list.  This property isn't available on the Lookup tab in table Design view. 

AutoExpand 
Specifies whether MS Access automatically fills in a value that matches the characters that you type in a combo box.  This property isn't available on the Lookup tab in table Design view.

DisplayControl  
Specifies the type of control (combo box or list box) that MS Access creates by default when you add a Lookup field to a form.  This property is available only on the Lookup tab in table Design view.

CREATING A FORM WITH A SUBFORM

To create forms, queries or reports using more than one table a legal relationship must exist.  Before using this procedure, make sure you've set up your table relationships correctly. 

Read these instructions and then complete the exercise below.  The instructions ARE NOT an exercise.  

1.
In any Microsoft Access window, click the arrow next to the new object button and then click New Form
2. 
In the New Form dialog box double click Form wizard in the list.

3.
In the first wizard dialog box, select the table or query for the main form.  For example, suppose you want to create a Customers form that has two subforms, an Orders subforms and an order details subform.  Select the Customers table.

4.
Click the fields you want to include from this table or query.

5.
In the same wizard dialog box, select the table or query for the first subform.  Using the same example, select the orders table, and then click the fields you want to include from this table or query.

6.
In the same wizard dialog box, select the table or query for the second subform.  Using the same example, select the orders details tableland then click the fields you want to include from this table or query.

7.
When you click next, if you set up the relationships correctly before starting the wizard, the wizard asks which table or query you want to view by.  Using the same example, to create the Customers form, click by customers.

8.
In the same wizard dialog box, select the Form/subform option.

9. Follow the directions in the remaining wizard dialog boxes. When you click Finish, Microsoft Access will create a form with two subform controls.  It also creates two other forms, one for each subform.  You will see them listed as Formname, Formname subform1 and Formname subform2.  (You can use this procedure to create a form and two subforms that have a one-to-many relationship.  The main form has a one-to-many relationship with the subform, and the first subform has a one-to-many relationship with the second subform.)

Linked forms are handled the same as embedded forms except they are not displayed on the screen.  Instead they have a button on the main form that opens the subform.

EXERCISE

Using the above procedure create a form with a subform using the Invoice and Invoice Detail Line tables. Save the form as Invoice entry.

COMPACTING A DATABASE

When you delete records in Access table, the space occupied by the deleted records on disk does not become available for other records (The records are not really deleted).  The same is true if you delete an object, such as a table, query, or form.  To make the space available, you must compact the database.  Compacting a database rearranges the data and objects in a database and creates a smaller copy of the database.  It actually moves the active records and writes over the space used by the deleted records/query/form.  Unlike making a copy of a database file, which you do to protect your database against loss or damage, you compact the database to make it smaller, thereby making more space available on your disk. 

1 Before compacting a database, you must close it.

2 Make sure the database you want to compact is closed.

3 In the Access window, click tools on the menu bar, point to database utilities

4 Click compact database to open the compact database dialog box

5 In the look in box select the drive and directory containing the database you to compact

6 In the filename box select the database you want to compact

7 Click the compact button.  Access opens the compact database into dialog box.

8 In the save in box select the drive and directory for the location of the compacted database

9 In the filename text box type the name you want to assign to the compacted database

10 Click the save button

REPORTS

To create a single table report

1 Click on the Reports tab in the database window

2 Select New

3 Select Report Wizard

4 Choose the table you want to use for your report from the drop down list or click next and select the table on the next screen.

5 Select the fields you want to have included in your report using the same method as selecting fields for a query

6 Click Next

7 Determine whether you want to have any grouping in the report and on which field you want it grouped. 

8 Click next

9 Set your sort criteria.  Access allows you up to 4 levels of sort

10 Click next

11 Format the layout and appearance in your next two screens

12 Give the report a name and click finish

EXERCISE:

Create a single table report to list all of the products, their price per unit and their number of units in stock.

NOTE:  BEFORE YOU CREATE A CUSTOM REPORT, YOU SHOULD FIRST PLAN THE          REPORT'S CONTENTS AND APPEARANCE

CREATING A CUSTOM REPORT

A report is a formatted hardcopy of the contents of one or more tables from a database.  Although you ca format and print data using data sheets, queries, and forms, reports allow you greater flexibility and provide a more professional, custom appearance.

An access report is divided into sections.

Report Headers/Footers   
contain any information that appears only once on a report. For example Title, Grand total, Author

Page Headers/Footers 
contain information that appears only once on each page.  For example current date, page number and column headings for each field. The column headings could also appear in the Group Header.

Group Headers/Footers  
contain information that appears only once for each group.  For example the Field name of the field you used for grouping, group totals, group counts etc

Detail Section 
 Contains all of the details in the report.

You don't have include all seven sections in your report.  When you design your report you determine which sections to include and what information to place in each section.

EXERCISE

Create a report using the Customer by City query grouping on City. (if you do not have a query that lists the customers by city create one first)

Select the city field and change the caption property

Right mouse on the field to drop down the quick menu and select Properties.  Type a new caption in the caption box.  This will change the text in the label but will not change the fieldname.

Resize the label boxes

When you try to move or resize the fields or labels you probably have noticed that what you do to one happens to both label and control.  To overcome this you must:

a) click on the field

b) move your cursor over the field

c) you will see a hand appear

d) if you move the field when you see all the fingers up you will move both the field and the label

e) move the cursor over the large box on the upper left corner of either the field or the label.  You will notice that now there is only one finger up.

f) Move the field or label.  You will notice that whatever you do happens only to the selected object.

g) To size label or control separately simply click the component you want and resize it.

Adding a date to a report.

1 Display the report in design view.

2 Click the text box tool on the toolbox

3 Position the pointer where you want the date to appear, and then click to place the text box in the report.

4 Click the text box, type =DATE() or NOW(), and then press the enter key.

EXERCISE

Using the same method as above add the page number to the page.

1 To add a title to a form or report select the Labels option on the toolbar 

2 Position the cursor where you want the title to start

3 Start typing.  The box will expand to accommodate the text

4 Format the text by highlighting the text and using the standard formatting methods

5 Size the box to fit the text after formatting

6 Save your report 
CALCULATING GROUP TOTALS AND OVERALL TOTALS.

Sue wants the report to print the value of the items in stock

1 Display the report in Design view.

2 Click the Text box tool on the toolbox.

3 Click the report section for the total, Group Footer for a group total, Page Footer for a page total, or Report Footer for an overall report total. In this case click on the Detail section of the report.

4 Right mouse click in the displayed text box and use the expression builder to build the following expression   =[Price per unit]*[Units in Stock]

5 In the properties box of the field select the “Other” tab and change the name from text## Extended Price.

6 In the Report footer section add another text box.

7 In this text box type =Sum([Extended Price])

8 Name this report  Inventory Value

INTEGRATING ACCESS WITH OTHER PROGRAMS

Sue is so pleased with the report you created for her that the she immediately thinks of another report that would be helpful with a graph showing the total amounts for the invoices for each month.

When you create a report or form in Access, you might want to include more than just the formatted listing of records.

EMBEDDING A CHART IN A REPORT.

Access provides the Chart Wizard to assist you in embedding a chart in a form or report.  The chart itself is actually created by another program, MS Graph, and automatically embedded by the chart wizard.  After embedding a chart in a report, you can edit it using the MS Graph program.

Open MSOffice\Access\Samples\Northwinds database and in the database window, click the Reports tab.

1 Click the New button to open the New Report dialog box.

2 Click chart wizard

3 Select the Product Sales for 1994  on which to base the report

4 Click the OK button.

5 The Charts Wizard will start

6 Follow the chart wizard's instructions to select the field(s) that contain the data for the chart,

7 Select the type of chart you want

8 Modify the layout of the chart

9 Enter a chart title.

10 Save the form with the chart.

Now use the Office Links button on the button bar at the top of the screen and Pubish this report to Word 

TO IMPORT AN ACCESS DATABASE TABLE

1. Open the database that is going to receive the imported table or other database object.

From the database window, click File, Get External data, Import.

2. Select MSOffice\ Access\Sampapps from the Look in window.

2. Select Northwinds Database

3. Click ok

4. An object window will be displayed

5. Select the object you want to import

6. Answer the remaining questions about saving the object

7. Finish

8. If there are errors importing data Access will create an error table to show you which records did not import cleanly.

EXERCISE:

Open your database and import the Customer file from Northwinds.  If you do not assign it a new name Access will call it Customer1 because you already have a customer table.

If you attempt to import anything other than another Access database table (you can import other objects from Access only) the Import Wizard will assist you by walking you through the procedure step by step.

EXPORTING AN ACCESS TABLE AS AN EXCEL WORKSHEET.

A spreadsheet program, such as MS Excel, is designed to assist you in analyzing data.  Although a database management program provides some data analysis capabilities, it is primary design for storing and retrieving information.  A spreadsheet program has many more powerful tools for analyzing data to create budgets, projections, and models.

To Export a database table to Excel:

1 Open the table you want to export in Datasheet view, or run the query to view the query results.

2 Click Tools on the menu bar

3 Point to Office Links

4 Click Analyze it with MS Excel.

5 The Query or table will be sent to MS Excel for analysis. It will have the same name as the Table or Query that was sent.

EXERCISE:

Export the Inventory or Product table to Excel.  Check the spreadsheet to be sure that the data exported cleanly.

EXPORT A TABLE OR QUERY TO A SPREADSHEET WITHOUT USING THE MACRO BUTTON

1 In the Database window, click the name of the table or query you want to export, and then 

2 In the File menu, click Save As/Export.

3 In the Save As dialog box, click To An External File or Database, and then click OK.

4 In the Save As Type box, click the spreadsheet format you want.

5 Click the arrow to the right of the Save In box and select the drive or folder to export to.

6 Double-click an existing spreadsheet, or enter a new name in the File Name box

7 CAUTION:  With two exceptions, if you export to an spreadsheet file, Microsoft Access deletes and replaces the data in that spreadsheet.  The exceptions occur when you export to a Microsoft Excel version 5.0 or 7.0 workbook, where the data is copied to the next available worksheet.

8 If you selected Microsoft Excel 5-7 in step 3 and you want to preserve fonts, preserve the displayed data from Lookup fields, and preserve field widths, select the Save Formatted check box.  Saving will be slower.

9 Click Export.

10 Microsoft Access creates the spreadsheet file containing the data from your table or query.  Field names from the table or query are placed in the first row of the spreadsheet.

EXERCISE:
Using the above method Export the new Customer database that you imported from Northwinds.

INTRODUCTION TO SWITCHBOARDS

A switchboard is a form that appears when you open a database and that provides controlled access to the database' s tables, forms, queries, and reports.  A good example of a Switchboard can be found in the Northwinds database.

When user opens the database Access displays a switchboard from which the user can choose an option.

When you create a switchboard, you are essentially creating a new interface and it's up to you to decide what options you want to give the user.

A switchboard gives an attractive look to a user interface, but there are two important reasons to use a switchboard instead of the database window to work with a database.

1. 
A switchboard lets you customize the organization of the user interface. 

2. A switchboard prevents users from changing the design of tables, forms, queries, and report 

When you use the Database Wizard to create a database, the wizard creates a switchboard that makes it easy to navigate between the forms and reports in your database. If you want to build the same type of switchboard for a database you created yourself, you can use the Switchboard Manager. 

1
On the Tools menu, point to Add-ins, and then click Switchboard Manager.

2
If Microsoft Access asks if you'd like to create a switchboard, click Yes.

3
In the Switchboard Manager dialog box, click Edit.

4
In the Edit Switchboard Page dialog box, type a name for the switchboard in the Switchboard Name box, and then click New.

5
In the Edit Switchboard Item dialog box, type the text for the first switchboard button, and then click a command in the Command box. For example, type Review Products, and then click Open Form In Edit Mode in the Command box.

Depending on which command you click, Microsoft Access displays another box below the Command box. Click an item in this box, if necessary. For example, if you click one of the form commands in the Command box, click the name of the form you want to open.

6
Click an item in the second box. For example if you clicked Open Form In Edit Mode in step 5, click Review Products in the Form box, and then click OK.

7
Repeat steps 4 through 6 until you've added all the items to the switchboard. If you want to edit or delete an item, click the item in the Items On This Switchboard box, and then click Edit or Delete. If you want to rearrange items, click the item in the box, and then click Move Up or Move Down.

8 Click Close. 

EXERCISE

Create a switchboard to open two of the forms you have created.  It really doesn’t matter which two.

INTRODUCTION TO MACROS

A macro is a command or a series of commands that you want Access to perform automatically for you.

Macros automate repetitive tasks, such as opening forms, printing reports, and running queries,

Each command in a macro is called an action.

An action is an instruction to Access to perform an operation, such as opening a form or displaying a report in the Print Preview window

Access lets you automate most tasks using either macros or visual basic.

As a beginner, you will find it easier to write macros than to create programs using visual basic.

CREATING MACROS

You create macros in the Macro window, which you display from the macros tab of the database window.  Open a customer form and you can create the following macro;

Click Macro tab

Click new

In the macro window you create and modify macros.  Both the menu bar and toolbar for the macro windows have options that are specifically related to macros,

The macro window also includes an ACTION COLUMN, in which you enter the action you want access perform, and a COMMENT COLUMN, in which you enter optional comments to document the specific action.

ARGUMENTS are additional facts access needs to execute an action.

You can select commands by clicking into the first cell and clicking on the down arrow that appears at the right end of the cell.

Place the following in the appropriate cells.

Action window: 

Open Form

Comment window: 
Open the customer form

Action arguments window:
Form Name:

CUSTOMER






View: 


Form






Window Mode: 
Normal

EXERCISE:

Write a macro to open customer form and invoice query

1 In the Macro Window click NEW

2 The Macro Action window opens

3 You will see an arrow on the right end of the action cell – click on the arrow

4 Select the action you wish to use – Open form

5 In the cell to the left of the action type “open customer form”

6 In the Argument box at the bottom Select the form name

7 Open the form in Form view

8 Where statement requires a SQL statement.  At this point it would be more practical to use a query and filter the information.

9 Open the form Read only

10 Select Run from the menu bar and run the Macro.

11 Save the macro as Open Customer

If you are interested in seeing exactly how your macro is running you can step it through one action at a time simply by selecting Step from the Run menu.  This is good for “debugging” if you have an error in your macro you can find exactly where the error occurs because the macro will halt before it executes the action that is creating the problem.

Put the command to MoveSize the window so that it appears at the bottom right hand side of the screen.  Remember that the coordinates are the upper left side of the box and are measured from the upper left side of the screen.  

Run your macro again and this time step through it.

ADDING A MSGBOX ACTION

The MsgBox Action causes Access to open a dialog box that remains on the screen until you click the OK button.  It is useful for error messages and reminders and takes the place of the pause to allow you to examine the form or information before proceeding to the next step of the macro.

The macro containing this action does not proceed to the next action until you click the OK button.

So when you add this action to your more practice macro, you'll have as much time as you need to look at the opened Customer form.

The MsgBox action requires four arguments:

1 The text that will appear in the MsgBox when it is displayed. [Message:  Click OK to resume the macro]. 

2 Beep: NO.  This means that no beep will sound when the message box is opened.

3 Type:  What icon do you want displayed in the MsgBox?

4 Setting:  The message to display in the MsgBox title bar.

Add a MsgBox to your Open Customer Macro.  Make this MsgBox beep and display a critical icon. Your message should read “Your application has crashed!!!”

Run the macro

Now add a Close Form Command

Run the macro

Now that you have created macros you will now use macros to create your own switchboard without the Switchboard Manager.

1 Click the Form tab on the database window.

2 Select New

3 Insert a picture from the clipart gallery

4 Add a header with a title “My Database Switchboard”

5 Around your picture insert several buttons.  Each button will run a command.

To add a button 

a) make sure that the Wizard button is pressed on your tool bar

b) press the command button button on the toolbar (if you cannot remember which one it is pass the cursor over each button pausing long enough for the label to appear to tell you what the button does.)

c) draw the button on the form

d) the Wizard will assist you through attaching a macro to your button.

e) To edit the macro you go into the buttons properties and edit the Event/Procedure cell by building or zooming (use the right mouse button)

6 Add in commands that will open 2 forms, run a query and print a report

7 Save the form under My Database Switchboard

EXERCISE:

Now, if you have time try to recreate the Invoice at the back of yesterday’s handout.
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TO INSERT A PICTURE					


When viewing an open form make sure that the wizard button at the top of the tool bar is pressed


Click on the Unbound Object button on the Tool Bar  


Draw a box on the form or screen


The wizard will guide you through the rest of the procedure


If you do not want to use the wizard draw the box


Open the Insert Menu


Choose MS ClipArt Gallery


Select a picture


Click Insert
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